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Release notes

This document contains the release notes for the IBM 5195 TotalStorage Network
Attached Storage 300, Model 326.

Refer to www.ibm.com/storage/support/nas for possible updates to these release
notes and for copies of the base documents.

Fixes and enhancements in this release
Your Model 326 comes with a preloaded set of software (described in detail in the
User’s Reference). As the preloaded software is updated with newer software
components (containing problem fixes, functional enhancements, or both), the
changes are applied in product manufacturing before the product is shipped to you.
For this reason, the exact release of preloaded software on your Model 326 might
vary, depending on when you received your Model 326.

To identify the exact release of preloaded software, from the Model 326 desktop
(using Terminal Services or direct-attached keyboard and monitor), click IBM NAS
Admin, and then on the left pane select Software Version. The first line of text that
appears on the right pane provides the software release (version and build
number).

The original level of Model 326 software is Version 2.0. The following sections
describe fixes and enhancements to newer levels of software, in reverse
chronological order. If you have an older version of Model 326 software and require
fixes or enhancements that are provided in newer versions, go to
http://www.ibm.com/storage/support/nas for information on obtaining those fixes and
enhancements. They might be provided in code packages that you must download
and install, in technical tips informing you of software configuration changes
(applied by IBM to later versions of Model 326 software preloads) that you must
apply, or as CDs for which you must contact IBM technical support to obtain and
install.

Fixes and enhancements in Version 2.5

Updated hardware drivers
The hardware drivers have been updated to newer versions.

Storage Manager for SAK Version 2.0
Release 2.5 includes Storage Manager for SAK Version 2.0, a storage management
tool that includes the following functions:

v Storage reports

v Directory quotas

v File screening

Storage reports address disk usage, wasted storage space, file ownership, security,
and administration. Reports can run interactively, scheduled on a regular basis, or
run as part of a storage resource-management policy when disk space utilization
reaches a critical level.
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Directory quotas allow the administrator to add, delete, monitor, and change disk
space limits for selected directories on the NAS appliance. Directory quotas provide
disk space monitoring and control in real time and supports active and passive
limits with two real-time space alarms.

File screening allows the blocking of any file type such as MP3, graphics files, VBS
viruses, and executables from writing to the NAS appliance.

Updated IBM ServeRAID Storage Manager
IBM ServeRAID™ Storage Manager has been updated to Version 4.84.

Tivoli Storage Manager LAN Free Support
Support for Tivoli® Storage Manager LAN Free Support has been added.

Uninterruptible power supply support
Release 2.5 includes support for uninterrupted power supplies (UPS). UPS devices
provide emergency backup power for a specific period of time when the local power
fails. This power comes from batteries housed within the UPS. High-performance
surge suppression helps protect your appliance from electrical noise and damaging
power surges. During a power failure, the UPS is designed to instantly switch your
appliance to emergency battery-backup power. After you have installed a UPS for
your appliance, you can set options for its operation using the UPS task on the
Maintenance page. The UPS task enables you to control how the UPS service
works on your appliance. The available UPS settings depend on the specific UPS
hardware installed on your system. Before you use your UPS device, type the
following information on the UPS Configuration page:

v UPS device manufacturer

v UPS device model

v The serial port to which the UPS device is connected

To configure the UPS service, click UPS on the Maintenance page.

To help protect your server appliance from power failures, test it by simulating a
power failure by disconnecting the main power supply from the UPS device. Do not
perform this test during production use. Your appliance and peripherals connected
to the UPS device should remain operational, messages should be displayed, and
events should be logged. Wait until the UPS battery reaches a low level to ensure a
proper shutdown occurs. Restore the main power to the UPS device, and check the
event log to verify that all actions were logged and there were no errors. All
detected power fluctuations and power failures are recorded in the event log, along
with UPS service start failures and appliance shutdown initiations. Critical events
might change the status of the appliance.

Enhanced NFS performance through Services for UNIX (SFU V2.2 +
QFE)

Services for UNIX® V2.2 + QFE provides increased performance for NFS V2.0.

Updated IBM FAStT Storage Manager
IBM FAStT Storage Manager has been updated to Version 8.20.
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Persistent Storage Manager problem fixes
Persistent Storage Manager (PSM) has been updated to Version 2.2 build 2222.1.
This level contains fixes for the following problems in PSM Version 2.2 build 2216.3.

Deleted persistent images might reappear after failover or reboot
Under certain conditions a persistent image that had been deleted might reappear,
although the deletion appeared to be successful at the time that it was performed
(the image does not appear on the PSM Persistent Images page and is not
accessible on the volume). A deleted persistent image could reappear under either
of the following conditions:

v The volume on which the persistent image was created is failed over between
nodes.

v The system is restarted.

Deletion of a persistent image does not immediately free up
cache space
The PSM cache usage for a particular volume does not immediately decrease when
a persistent image on that volume is deleted. The corresponding decrease occurs
on the next persistent image deletion on that volume. Also, during system startup,
the cache usage might increase.

In PSM Version 2.2 build 2222.1, the persistent image is deleted immediately and
all of its associated cache space is immediately freed up.

Under heavy write activity, writes might freeze while Volume
Settings page is being loaded
If there is heavy write activity to one or more volumes on the NAS appliance and
the PSM Volume Settings page is requested (in the Windows® 2000 for NAS GUI,
either on the local console or using a Web browser over the network), then all write
activity might freeze for up to 90 seconds while the page is being loaded.

NAS Setup Navigator
Version 2.5 of the Model 326 includes the NAS Setup Navigator configuration tool.
The NAS Setup Navigator maps out the initial configuration tasks and leads you
through the tasks in the proper order. The tool detects which NAS appliance it is
running on and adjusts the menu and content appropriately. You can follow links to
more in-depth information and to the configuration panels used to perform the
steps. You can also tailor the instructions to fit your needs by selecting optional
topics. To start the NAS Setup Navigator, click on the NAS Setup Navigator icon on
the desktop.

Tivoli Storage Manager
Tivoli Storage Manager (TSM) 4.2.2 server, client, and agent are included on the
Supplementary CD. The client and agent are also available on the Web at:

www.ibm.com/storage/support/nas

Functional notes
The following sections contain functional information.

Release notes 3

http://www.ibm.com/storage/support/nas


Updated information on joining a node to a domain (in cluster setup)
The following information replaces the information in the section titled “Joining a
node to a domain” in Chapter 5 of the User’s Reference. This information is also
included in the NAS Setup Navigator (described in “Fixes and enhancements in
Version 2.5” on page 1).

For the Windows Cluster service to form a cluster on a given node, the service
must authenticate with a Windows domain. If a Windows domain controller is
available on a public network to which both nodes will be physically connected,
follow the instructions in “Joining a node to a domain”. Otherwise, follow the
instructions in “Creating an Active Directory domain” to create a new domain that
will encompass just the cluster itself.

Joining a node to a domain
All nodes in the cluster must be members of the same domain and be able to
access a Primary Domain Controller (PDC) and a DNS Server.

Note: The administrator must have a valid domain account on the PDC.

1. Right-click My Computer, and click Properties.

2. Click Network Identification. The System Properties dialog box displays the full
computer name and workgroup or domain.

3. Click Properties and perform these steps to join a domain:

a. Select the Domain radio button.

b. Type the name of your domain and click OK.

c. When prompted, enter the Administrator user ID and password and click
OK.

4. Close the System Properties window.

5. Restart the node, and proceed with “Cluster setup.”

After the computer restarts, it is recommended that you do not log in to the
domain. If you do, you will see the Windows 2000 Configure Your Server
window. Click the I will configure this server later radio button, and then click
Next. On the next window, clear the Show this screen at startup check box and
click Finish.

Creating an Active Directory domain
The Windows 2000 Cluster service runs in the context of a Windows-based domain
security policy, typically created specifically for the Cluster service to use. For the
Cluster service to form a cluster on a given node, the service must first authenticate
itself using the credentials of this policy. A domain controller must be available for
the domain that issued the policy for authentication to occur. If the Cluster service
does not have access to a domain controller, it cannot form a cluster.

Note: For Active Directory to function properly, DNS servers must provide support
for Service Location (SRV) resource records described in RFC 2052, A DNS
RR for specifying the location of services (DNS SRV). SRV resource records
map the name of a service to the name of a server offering that service.
Active Directory clients and domain controllers use SRV records to
determine the IP addresses of domain controllers. Although not a technical
requirement of Active Directory, it is highly recommended that DNS servers
provide support for DNS dynamic updates described in RFC 2136,
Observations on the use of Components of the Class A Address Space
within the Internet.
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The Windows 2000 DNS service provides support for both SRV records and
dynamic updates. If a non-Windows 2000 DNS server is being used, verify that it at
least supports the SRV resource record. If not, it must be upgraded to a version
that does support the use of the SRV resource record. A DNS server that supports
SRV records but does not support dynamic updates must be updated with the
contents of the Netlogon.dns file created by the Active Directory Installation wizard
while promoting a Windows 2000 Server to a domain controller.

By default, the Active Directory Installation wizard attempts to locate an authoritative
DNS server for the domain being configured from its list of configured DNS servers
that will accept a dynamic update of an SRV resource record. If found, all the
appropriate records for the domain controller are automatically registered with the
DNS server after the domain controller is restarted.

If a DNS server that can accept dynamic updates is not found, either because the
DNS server does not support dynamic updates or because dynamic updates are
not enabled for the domain, the following steps are taken to ensure that the
installation process is completed with the necessary registration of the SRV
resource records:

1. The DNS service is installed on the domain controller and is automatically
configured with a zone based on the Active Directory domain.

For example, if the Active Directory domain that you chose for your first domain
in the forest was example.microsoft.com, a zone rooted at the DNS domain
name of example.microsoft.com is added and configured to use the DNS
service on the new domain controller.

2. A text file containing the appropriate DNS resource records for the domain
controller is created.

The file called Netlogon.dns is created in the %systemroot%\System32\config
folder and contains all the records needed to register the resource records of
the domain controller. Netlogon.dns is used by the Windows 2000 NetLogon
service and to support Active Directory for non-Windows 2000 DNS servers.

If you are using a DNS server that supports the SRV resource record but does not
support dynamic updates (such as a UNIX-based DNS server or a Windows NT
Server 4.0 DNS server), you can import the records in Netlogon.dns into the
appropriate primary zone file to manually configure the primary zone on that server
to support Active Directory.

If you are configuring the first node, complete these steps to create the Active
Directory Domain Controller:

1. Start the Active Directory Installation wizard from the IBM NAS Admin console
by selecting Local Domain Controller Setup in the Cluster Tools folder.

2. Read the first page and click Next.

3. On the Domain Controller Type page, select Domain controller for a new
domain, then click Next.

4. On the Create Tree or Child Domain page, select Create a new domain tree,
then click Next.

5. On the Create or Join Forest page, select Create a new forest of domain
trees, then click Next.

6. On the New Domain Name page, type the full DNS name for the new domain.
Write down this value now; it will be needed later on. Click Next.

7. On the NetBIOS Domain Name page, click Next.
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8. On the Database and Log Locations page, click Next to accept the default
values.

9. On the Shared System Volume page, click Next to accept the default value.

10. On the Permissions page, select Permissions compatible only with
Windows 2000 servers, then click Next.

11. On the Directory Services Restore Mode Administrator password, type your
password. Write down this value now; it will be needed later on. Click Next.

12. On the Summary page, review the values, click Next and wait for the
Configuring Active Directory process to complete.

13. On the Active Directory Installation Wizard page, click Finish. If prompted,
defer the system reboot.

14. Restart the node.

If you are configuring the joining node, perform these tasks to join this node to the
existing Active Directory Domain Controller (previously created on the first node):

1. Start the Active Directory Installation Wizard from the IBM NAS Admin console
by selecting Local Domain Controller Setup in the Cluster Tools folder.

2. Read the first page and click Next.

3. On the Domain Controller Type page, select Additional domain controller for
an existing domain, then click Next.

4. On the Network Credentials page, type the user name (Administrator),
password, and domain name (enter the Active Directory Domain name created
on the other node), then click Next.

5. On the Additional Domain Controller page, type the full DNS name of the
existing domain, then click Next.

6. On the Database and Log Locations page, click Next to accept the default
values.

7. On the Shared System Volume page, click Next to accept the default value.

8. On the Directory Services Restore Mode Administrator password page, type
your password. Write down this value now; it will be needed later on. Click
Next.

9. On the Summary page, review the values, then click Next. Wait for the
Configuring Active Directory process to complete.

10. On the Active Directory Installation Wizard page, click Finish. If prompted,
reboot the system now.

Additional information on IBM Director

Real Time Diagnostics and Electronic Service Agent not
available
The Real Time Diagnostics function and Electronic Service Agent™ (eSA) features
of IBM Director are not available in this release of the Model 326. Disregard the
information presented on these two functions in Chapter 6 of the User’s Reference.

Rack Manager enhancements
This information is a clarification of the information in the section titled “Rack
Manager and inventory enhancements” in Chapter 6 of the User’s Reference.

The Rack Manager Task enhancements to recognize IBM NAS components are
part of the IBM Director Server Service Pack Version 3.1.1. To use this feature, the
IBM Director Service Pack 3.1.1 must be loaded on the IBM Director server.
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Best Practices does not display results when default location of output
is changed

Storage reports address disk usage, wasted space, file ownership, security, and
administration. Reports can run interactively, be scheduled on a regular basis, or
run as part of a storage resource-management policy when disk space utilization
reaches a critical level. The Best Practices report is a representation of
storage-management best practices that are a good starting point for disk space
analysis. The Best Practices reports give an overall indication of your system’s
storage health. The report identifies file types, duplicate files, files that are not
backed up, the most commonly-used files, and nightly backup capacity
requirements. Several options are available when creating the reports, such as the
format of the report and output location. If you choose to store the output
somewhere other than the default location, the report will not display automatically;
however, the report is still generated and can be displayed when accessed.

Error 508 after using the Recovery CD Set
When an image is built on a nonmirrored system and is recovered on a RAID
mirrored system, Error 508 might occur. This error also occurs when an image is
restored to any hard drive configuration that is different from the configuration
where the image was created (for example, moving from 36.4-GB to 73.4-GB drives
or a different ServeRAID controller). Error 508 occurs after the recovery process
and before Windows Powered starts. The text of the error message is as follows:
As specified, the operation does not change the partition

The error message appears when the requested partition size is aligned with a
cylinder boundary that is the same cylinder boundary as the existing partition size.

Note: This message is informational only and does not require action.

UPS service error
On the Status of the Windows 2000 for NAS GUI, you will see that the UPS service
has been stopped.

To configure and enable the UPS service using the Windows 2000 for NAS GUI:

1. Click Maintenance → UPS.

2. Select the manufacturer, model, and COM port that your UPS is attached to.

3. Select the Enable the UPS service on this appliance check box and click OK.

Note: Do not enable the UPS service unless you have a UPS attached to your
appliance.

Fibre Channel adapter device driver not updating properly
When you check the version level of the device driver for the Fibre Channel Host
Bus Adapter, it might appear to be an incorrect version. The proper way to verify
the version level is to perform the following steps:

1. Right-click My Computer and select Properties.

2. Under the Hardware tab, click Device Manager.

3. Expand SCSI and RAID Controllers.

4. Right-click QLA2200 PCI Fibre Channel Adapters and select Properties.

5. Under the Driver tab, click Driver Details. The correct version should be
8.1.4.60 (W2K IP).
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This problem occurs when Windows Powered does not update the associated
OEM.INF file. This does not affect the function of the driver. The procedure above
should be used to determine the correct version of the driver when calling IBM
Support.

Error when trying to disable port A on Alacritech 10/100 Quad-Port
Ethernet adapter

If you attempt to disable port A on the Alacritech 10/100 Quad-Port Ethernet adapter
by right-clicking My Network Places on the desktop, then right-clicking Alacritech
Port A, the following message appears:
It is not possible to disconnect at this time. This connection may be using
one or more protocols that do not support Plug-and-Play, or it may have been
initiated by another user or the system account.

Click OK. There will be no indication that the port has been disabled. You must
reboot the appliance before the port will be disabled.

Alacritech adapter not prompting to reboot after deleting adapter team
Although you are not prompted to reboot the appliance after you delete an adapter
team on the Alacritech 10/100 Quad-Port Ethernet adapter, you must reboot the
appliance at this time.

You will see an indication that a reboot is needed by performing the following steps:

1. Right-click My Network Places and select Properties.

2. Right-click Port A of Alacritech Adapter and select Properties.

3. Click Configure and the Properties page appears. A message indicating a
reboot is necessary is under Device Status.

4. Click OK. A message that a reboot is now needed appears.

Windows 2000 for NAS GUI tabs not working correctly
If you connect remotely to the NAS appliance through port 8099 using the fully
qualified IP address, you might see the following message if you click on a link that
launches Terminal Services:
Cannot access this program in the current browser zone.

There are two ways to resolve this problem:

v In the browser address field, use the hostname of the NAS appliance you are
connecting to (for example, http://IBM5194-23A1055:8099).

v From Internet Explorer, select Tools → Internet Options → Security → Trusted
Sites → Sites. Clear the Require server verification (https:) for all sites in this
zone check box and add the fully qualified IP address of the NAS appliance.

Japanese text not displaying correctly in NAS Setup Navigator
If you change the language in the Windows 2000 for NAS GUI to Japanese, some
of the characters in the NAS Setup Navigator might not display correctly. You can
correct this problem by performing the following steps:

1. Open Internet Explorer.

2. Go to View → Encoding.

3. Ensure that Auto-Select is not selected.

4. Ensure that Shift-JIS is selected.
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File and Print Services for NetWare error
When installing or configuring the Services for NetWare 5 software on the NAS
appliance, the following errors might appear in the event log:
Event Type: Error
Event Source: FPNWSRV
Event ID: 2011
Description: The server’s configuration parameter "irpstacksize" is too small
for the server to use a local device. Please increase the value of this parameter.

To download a fix for this problem, go to the IBM support Web site at
www.ibm.com/storage/support/nas and click Network Attached Storage (NAS)
under Technical Support.

FAStT controller might go offline when a failure occurs
If the ISL cable connecting the two Fibre Channel hubs fails in a clustered
configuration, one of the FAStT controllers will go into offline state. This is the
expected behavior for this configuration. In this situation, the FAStT controller has
not failed and does not need to be replaced. If you find an offline FAStT controller,
check the ISL cable before continuing on to diagnostic procedures for the controller.

Microsoft DTC service error message
You might receive an error message in your event log similar to the following:
MS DTC has determined that the cluster service is installed
but not running when MS DTC was started. MS DTC will continue
to startup but it will not failover. Additionally, if the
cluster service is started then please shut down this instance
of MS DTC as it will become unusable.

If you receive this error message, stop and restart the service mentioned in the
message. This can occur with any service that needs to be switched to the other
node if the current node fails.

Cluster configuration considerations for the Cluster Group
When you create the cluster between the two nodes of the Model 326, a default
group named Cluster Group is created. This group contains the following resources,
related to cluster administration:

v The cluster Quorum disk

v The IP address you defined for the cluster

v The cluster name

Do not add other resources to this group; this might hinder your ability to administer
the cluster. Also, failure of any additional resources within the Cluster Group might
trigger failover or inability to successfully administer the cluster.

You do not need to consider the Cluster Group in the load balancing scheme, as
the group is for cluster administration only. You can balance the other resources on
the two nodes independently of the Cluster Group.

Administration notes
This section contains administration information.
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Updated information on Supplementary CDs
This information replaces the information in the section titled “Using the
Supplementary CD” in Chapter 9 of the User’s Reference.

The Supplementary CDs contain documentation and copies of key software
applications that are preinstalled on the Model 326. Table 1 and Table 2 include the
names of the directories found on the Supplementary CDs and a description of the
contents of the directory.

Table 1. Supplementary CD 1 directories

Directory name Contents

DB2 v EnableDB2Support.exe
v DisableDB2Support.exe

These files enable and disable support for Linux- and Solaris-based DB2® clients using
NFS shares.

DiskImages Contains diskette image for the Recovery Enablement Diskette and a diskette image
for a bootable diskette that automatically configures the ServeRAID controller and
drives.

To create the Recovery Enablement Diskette, run enablement_diskette25.exe and
insert a HD 1.44 floppy diskette into drive A: when prompted.

To create the bootable diskette to automatically configure the ServeRAID controller and
drives, run IBM_NAS_AutoRAID_diskette_2.5.EXE and insert a HD 1.44 floppy diskette
into drive A: when prompted.

diskpart Samples This directory contains an example script for use with the DiskPart utility. This script will
clean disk 2, convert it to dynamic, partition it, and assign drive letters to the partitions.
This script is unsupported and should be used with extreme caution.

IBM Advanced Appliance
Configuration

Run Setup.exe on the machine from which you will administer the appliance. The agent
is pre-installed on the appliance.

IBM NAS Extensions For
IBM Director

The IBM NAS extensions to IBM Director provide capabilities to IBM Director that are
specific to the IBM NAS appliances.

Zip Tools Contains compression tools used for sending information to IBM technical support.

readme.txt This is a text file that describes the contents of the Supplementary CDs.

Table 2. Supplementary CD 2 directories

Directory name Contents

AoP This is the add-on pack for the Server Appliance Kit.

SFU_2073.1 Microsoft Services for UNIX (SFU) Version 2.2 support files:

v QFE 320175 for performance enhancements

v QFE 321096 for SAK and SFU performance enhancements

readme_SFN5.txt: Instructions for installing Microsoft File and Print Services for
NetWare 5.0.

Terminal Services Client Microsoft Terminal Services Client install files.

w2ksp2 Windows 2000 Service Pack 2.

OpenHCD USB controller warning
Any warning (Yellow Explanation) indication in Device Manager, under Universal
Serial Bus Controller, Standard OpenHCD HSB Host Controller, should be ignored.
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The warning is an indication that the device cannot find enough free resources and
does not affect product function or performance.

Attention: The USB controller is not supported in this appliance.

5191 RAID Storage Controller event logs
The 5191 RAID Storage Controller event log lists errors and failures that occur. To
view this log, click Start → Programs → Event Viewer. Table 3 lists the most
common events.

Table 3. Common 5191 RAID Storage Controller events

Event Label identifier Description

3 IO_ERR_CONFIGURATION_ERROR

4 IO_ERR_LAYERED_FAILURE Driver beneath this layer failed.

18 IO_ERR_DRIVER_ERROR Driver detect internal data structure error.

Event 18 indicates that components along the path from the host bus adapter to the
controller might be generating errors. These components include the host bus
adapter, Fibre Channel cable, GBIC, hub, and so on.

If multiple occurrences of event 18 occur, the earliest log entry is probably
associated with the original failure. Later entries of event 18 on other nodes are
most likely responses to the original failure. They also usually contain an SRB
status of 0x0a, SCSI selection timeout. You must check the system’s date and time
stamp for synchronization to verify which entry has the earliest time (and is
therefore indicating the original failure).

The following example demonstrates an error message produced by RDAC during
normal execution. This information can be obtained by selecting an event’s
properties and viewing the raw data as Words:
Event Type: Error
Event Source: Rdacfltr
Event Category: None
Event ID: 4
Date: 9/15/2000
Time: 11:41:40 AM
User: N/A
Computer: ICTTOP1
Description:
Driver detected an internal error in its data structures for
\Device\Rdac\ICTTOP_001\B\P2P0I5\5.
Data:
0000: 00180000 006e0001 00000000 c0040004
0010: 00000125 00000000 00000000 00000000
0020: 00000000 00000000 00020005 00000004
0030: 00000000 00000025 00000a00 00000000

A breakdown of the data is shown in Table 4.

Table 4. Breakdown of data from example

0018 0000 006e 0001 0000
0000 c004 0004

0018 DumpDataSize

00 RetryCount

00 MajorFunctionCode
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Table 4. Breakdown of data from example (continued)

006e StringOffset

0001 NumberOfStrings

0000 Byte Boundry Padding

0000 EventCategory

C004 0004 ErrorCode

0000 0125 0000 0000 0000
0000 0000 0000

0000 0125 UniqueErrorValue

0000 0000 FinalStatus

0000 0000 SequenceNumber

0000 0000 IoControlCode

0000 0000 0000 0000

0000 0000 0000 0000 DeviceOffset

0200 0505 0000 0004 0000
0000 0000 0025 0000 0a00
0000 0000

DumpData

DumpData[0] 0002 Port

0005 Path

DumpData[1] 0000 0004 ID

DumpData[2] 0000 0000 LUN

DumpData[3] 0000 0025 Command (from the CDB)

DumpData[4] 0000 0a00

xxyy

xx – SRB status

yy – SCSI status

DumpData[5] 0000 0000

aabb ccdd

aa – ASCQ

bb – ASC

cc – Sense Key

dd – FRU

Table 5 summarizes the values found in the UniqueErrorValue field and are
produced by RDAC during normal execution.

Table 5. UniqueErrorValue field values

Status code Message

0x116 The maximum number of paths to a controller have been exceeded.
RDAC currently supports only one path to a controller (SM 7.x) or up
to 4 paths to a controller (SM 8.x).

0x117 WWN mismatch on two sides of a LUN.

0x118 Unable to allocate an RDAC structure.

0x119 Could not create a device object or directory during an “AddDevice”
request.

0x122 A controller failover occurred due to an I/O error. Examples of this
include resets and LUNs becoming ready.
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Table 5. UniqueErrorValue field values (continued)

Status code Message

0x123 A path to a multipath controller has failed.

0x124 A controller failover has failed. No retries will be performed.

0x125 Controller failover event due to all paths being removed. LUN is
configured and owned by the alternate. The current path is changed
and a MODE_SELECT request (RDAC Classic only) is issued.

0x126 Controller failover due to some LUNs being owned by an
inaccessible alternate controller at startup.

0x201 SCSI recovered error on a controller.

0x202 SCSI hardware error on a controller.

0x203 SCSI unit attention on a controller.

0x204 SCSI aborted command on a controller.

0x205 SCSI media error on a controller.

Also, the ErrorCode field will vary depending on the sense data (see Table 6).

Table 6. Sense data

Sense key RDAC status
code

ErrorCode

1 0x201 IO_ERR_RETRY_SUCCEEDED
(Event ID 1)

3 0x205 IO_ERR_BAD_BLOCK (Event ID 7)

4

(ASCs of 0x0c, 0x3[1,2],
0x4[0,3,4,5,b], 0x8[0.5.7], 0x95,
0xc0, 0xd0, 0xd1, 0xe1)

0x202 IO_ERR_CONTROLLER_ERROR
(Event ID 11)

6

(ASCs of 0x0c, 0x11, 0x3f, 0x40,
0x8[7,8,E], 0x9[1,5,8],
0xa[0,1,4,6,7], 0xc0)

0x203 IO_ERR_INTERNAL_ERROR (Event
ID 12)

0xb

(ASCs of 0x4[4,7,8,9,E])

0x204 IO_ERRO_CONTROLLER_ERROR
(Event ID 11)

Table 7 shows the SRB status codes that are defined.

Table 7. Defined SRB status codes

Label identifier Code

SRB_STATUS_PENDING 0x00

SRB_STATUS_SUCCESS 0x01

SRB_STATUS_ABORTED 0x02

SRB_STATUS_ABORT_FAILED 0x03

SRB_STATUS_ERROR 0x04

SRB_STATUS_BUSY 0x05

SRB_STATUS_INVALID_REQUEST 0x06
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Table 7. Defined SRB status codes (continued)

Label identifier Code

SRB_STATUS_INVALID_PATH_ID 0x07

SRB_STATUS_NO_DEVICE 0x08

SRB_STATUS_TIMEOUT 0x09

SRB_STATUS_SELECTION_TIMEOUT 0x0A

SRB_STATUS_COMMAND_TIMEOUT 0x0B

SRB_STATUS_MESSAGE_REJECTED 0x0D

SRB_STATUS_BUS_RESET 0x0E

SRB_STATUS_PARITY_ERROR 0x0F

SRB_STATUS_REQUEST_SENSE_FAILED 0x10

SRB_STATUS_NO_HBA 0x11

SRB_STATUS_DATA_OVERRUN 0x12

SRB_STATUS_UNEXPECTED_BUS_FREE 0x13

SRB_STATUS_PHASE_SEQUENCE_FAILURE 0x14

SRB_STATUS_BAD_SRB_BLOCK_LENGTH 0x15

SRB_STATUS_REQUEST_FLUSHED 0x16

SRB_STATUS_INVALID_LUN 0x20

SRB_STATUS_INVALID_TARGET_ID 0x21

SRB_STATUS_BAD_FUNCTION 0x22

SRB_STATUS_ERROR_RECOVERY 0x23

SRB_STATUS_NOT_POWERED 0x24

Fibre Channel adapter event logs
You can view event logging for the Fibre Channel adapter for troubleshooting
problems using the event viewer. The detailed event code is displayed at offset 34
(hex). Table 8 gives a list of detailed event codes for the adapter. For some of the
event codes, additional data will be recorded in the least significant 16 bits of the
longword. Additional data might also be recorded in the longword at offset 10 (hex).

Certain codes will be logged only if you set a Fast!UTIL parameter to enable
additional event logging. These codes are indicated by an asterisk (*). By default,
these events are not logged.

If an error occurs that is not listed in Table 8, contact the IBM Support Center (1
800 426-7378 in the U.S.). In all other countries, contact your IBM reseller or IBM
marketing representative.

Table 8. Fibre Channel adapter error codes

Event code
offset 34h

More data
offset 10h

Description Suggested action

4002xxxx yyyy00zz Host interface error: xxxx =
mailbox1; yyyy = mailbox2; zz =
command

Hardware DMA
error: replace
adapter

4005xxxx Yyyy00zz Mailbox command error: xxxx =
mailbox1; yyyy = mailbox2; zz =
command

Normally indicates
loop down, check
all cabling
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Table 8. Fibre Channel adapter error codes (continued)

Event code
offset 34h

More data
offset 10h

Description Suggested action

4005xx6F yyyyyyzz Login Fabric port mailbox command
error: xx = adapter; state yyyyyy =
port id; zz = loop id

Normally indicates
loop down, check
all cabling

* 80010000 00000000 Reset detected Not logged during
normal operation

8003xxxx yyyyzzzz RISC request queue transfer error:
xxxx = mailbox1; yyyy = mailbox2;
zzzz = mailbox3

Hardware error:
replace adapter

8004xxxx yyyyzzzz RISC response queue transfer error:
xxxx = mailbox1; yyyy = mailbox2;
zzzz = mailbox3

Hardware error:
replace adapter

* 80100000 0000xxxx LIP occurred: xxxx = mailbox1 Not logged during
normal operation

* 80110000 xxxxyyzz Link up 2200: xxxx = current ISP
connection mode (0 = Loop, 1 =
P2P); yy = ISP connection option 0
= Loop, 1 = P2P, 2 = Loop->P2P, 3
= P2P->Loop; zz = starting loop id
for remote devices. 2100: xxxx =
0000; yyyy = 0000

Not logged during
normal operation

80120000 00000000 Link down error Not logged during
normal operation

80130000 0000xxxx LIP reset occurred: xxxx = mailbox1 Not logged during
normal operation

**80300000 xxxxyyzz Link mode up: xxxx = current ISP
connection mode 0 = Loop 1 = P2P;
yy = ISP connection option (0 =
Loop, 1 = P2P 2 = Loop->P2P 3 =
P2P->Loop); zz = starting loop id for
remote devices

Not logged during
normal operation

**8036aabb xxxxyyzz Point-to-Point update configuration:
xxxx = mailbox1; yy = current ISP
connection mode (0 = Loop, 1 =
P2P); zz = ISP connection option 0
= Loop, 1 = P2P, 2 = Loop->P2P, 3
= P2P->Loop; aa = starting loop id
value for remote devices; bb =
current retry count for the ISP
initialization mode

Not logged during
normal operation

* F0000000 00000000 Restarting RISC firmware Initial driver load or
loop down longer
than 4 minutes

* F0030004 00xx00yy Reset command completion error: xx
= CDB opcode; yy = target loop ID

Not logged during
normal operation

* F0030005 00xx00yy Command aborted by OS: xx = CDB
opcode; yy = target loop ID

Not logged during
normal operation

F0030028 00xx00yy Port unavailable, command
completion error: xx = CDB; opcode
yy = target loop ID

Check target device
and cabling
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Table 8. Fibre Channel adapter error codes (continued)

Event code
offset 34h

More data
offset 10h

Description Suggested action

F0030029 00xx00yy Port logged out command
completion error: xx = CDB; opcode
yy = target loop ID

Check target device
and cabling

F003001C 00xx00yy Target device queue full (SCSI
status 28 from target): xx = CDB
opcode; yy = target loop ID

Check target device
and cabling

* F00A0000 0000xxxx RISC firmware state during adapter
initialization: xxxx = firmware state

Not logged during
normal operation

F00B0000 00000000 Reset ISP chip failed

F00D0000 00000000 Fail to allocate non-cached memory

F00E0000 00000000 Fail to map ISP registers

F00F0000 00000000 Fail to load RISC code

F0100000 0000xxxx Fail to start RISC code: xxxx =
mailbox0

F0110000 0000xxxx Fail to initialize firmware xxxx =
mailbox0

F0120000 0000xxxx Fail to get firmware state: xxxx =
mailbox0

* F0130000 00000000 Port Update notification (RISC
database changed)

* F0140000 xxxxxxxx RSCN notification (Name server
change detected): xxxx = RSCN
Information

* F0150000 00xx00yy Name server query rejected (v6
2100): xx = Reason Code; yy =
Explanation Code (Valid if reason
code is 0x09)

* F0150000 xxxxyyzz Name server query rejected (v7
2100/2200): xxxx = response status;
yy = Reason Code; zz = Explanation
Code (Valid if reason code is 0x09,
for example, if zz = 0x09, yy = 07,
this means no SCSI device found.)

* F0160000 00000000 Driver reset called; command timed
out

* F0170000 00xxxxxx Fabric port login (for information
only): xxxxxx = Port Id

F0180000 000000xx Excessive link errors, loop down: xx
= number of link errors per second

* F0190000 00000000 Verify firmware checksum failure

* F01B0000 000000xx Device marked offline after being
not-ready longer than port down
retry count: xx = loop ID of device

* F01C0000 000000xx Bad type field in IOCB from RISC:
xx = IOCB type

* F01D0000 00000000 Error downloading post RISC code
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Table 8. Fibre Channel adapter error codes (continued)

Event code
offset 34h

More data
offset 10h

Description Suggested action

* F01Exxxx Yyyyzzzz Error running post RISC code: xxxx
= mailbox0; Yyyy = mailbox1; zzzz =
mailbox2

* F01Fxxyy Zzzzzzzz DMA 64 bit (PAE) configuration (for
information only): xx =
Dma64BitAddressess flag set by
W2K; yy = Dma64BitAddressess
flag set by driver; zzzzzzzz = driver
adapter flags

F0200000 Xxxxyyyy Error ISP not accessible: xxxx = ISP
host command and control; yyyy =
ISP interrupt status

* F0210000 xxyy00zz ISP connection option/topology (for
information only): xx = ISP
connection option from NVRAM; yy
= previous ISP topology; zz =
current ISP topology code: 0000 =
Loop, 0001 = FL_Port, 0002 =
N_Port to N_Port, 0003 = F_Port

* F0220000 0000xxxx External RISC ram parity error (for
2200G only): xxxx = number of
parity errors detected

* F0230000 Xxxxyyyy Subvendor Id not match (for
information only): xxxx = actual
subvendor id; yyyy = expected
subvendor id

FAStT Storage Manager automatic discovery of storage subsystems
The section titled “Starting Enterprise Management” in Chapter 4 of the User’s
Reference describes the IBM FAStT Storage Manager automatic-discovery feature,
which discovers all hosts and storage subsystems on the local subnetwork. If you
launch FAStT Storage Manager on the Model 326 (as opposed to a separate
Windows 2000 client computer) and perform automatic discovery (by clicking Yes
on the Confirm Initial Automatic Discovery panel that appears when you launch the
application), be aware that FAStT Storage Manager is fully capable of managing
any subsystems that are discovered, even if you want to manage only the
subsystems that are contained in the Model 326. When automatic discovery has
completed, the host for the Model 326 (containing its subsystems) can be identified
from the device tree (in the left pane of the Enterprise Management window) by the
Model 326 machine name (this is also listed as the root of the device tree).

If you do not perform automatic discovery, you must manually add the storage
subsystems of the Model 326 by performing the following procedure in the
Enterprise Management window:

1. From the menu bar, select Edit → Add Device....

2. Type the Model 326 system name (displayed in the top of the left pane of the
Enterprise Management window) in the Add Device panel, then click Add. The
host and storage subsystems for the Model 326 should be added to the device
tree in the left pane of the Enterprise Management window.

3. Click Close.

Release notes 17



Trademarks
DB2, IBM, the IBM logo, IBM Director, SANergy, ServeRAID, TotalStorage, Tivoli
and are trademarks or registered trademarks of International Business Machines
Corporation or Tivoli Systems Inc. in the United States, other countries, or both.

Alacritech and SLIC Technology are registered trademarks of Alacritech, Inc. in the
United States, other countries, or both.

Microsoft, Windows, and Windows NT are trademarks or registered trademarks of
Microsoft Corporation.

Persistent Storage Manager is a trademark of Columbia Data Products, Inc.

UNIX is a registered trademark in the United States, other countries, or both, and is
licensed exclusively through X/Open Company Ltd.

Other company, product, and service names may be trademarks or service marks
of others.
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